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View windows for the 2D display of geospatial data are an
integral part of many processes in the TNTgis software prod-
ucts. This document provides an overview of the main
components of the View window, which are illustrated above.

View Canvas

The view canvas is the large area of the View window in which
the geospatial data layers are drawn. As you move the mouse
pointer over these data layers, popup DataTips show selected
attribute information about the elements in these layers. You
can use a number of graphic tools in the view canvas to change
the display and explore the data layers. An optional scale bar
can be shown in the view canvas (see the Scale Bar section
below).

Toolbar

The toolbar is the row of icon buttons above the view canvas.
These icon buttons are organized by function (see illustration
below) and the function of each icon button is indicated by a
ToolTip when you place the mouse pointer over it. The but-
tons in the View toolbar let you zoom the view and perform
other content functions. The Add Layer icon button lets you
add any type of geospatial data layer directly from the View
window. The Mark toolbar provides controls for marking geo-
metric elements in the view canvas. The Tool toolbar lets you
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activate various graphic tools that you can use in the view
canvas. For a complete description of the View window toolbar
see the Technical Guide entitled View Window Toolbar.

Sidebar

The sidebar is an optional area along the left or right side of the
View window in which you can show a legend, a Locator panel,
and other panels with controls that let you change and explore
the contents of the display. The panels in the sidebar can be
opened or closed separately using icon buttons in the toolbar at
the bottom of the sidebar (see illustration below). The entire
sidebar can be closed or opened at any time using the small
black arrow icon button (see illustration above). You can set
the location of the sidebar on the left or right side of all View
windows using the Sidebar Location controls on the View tabbed
panel of the Options window

opened from the Display Manager Sidebar Icon Buttons

(Options / View Options). For  Legend Locator Zoom
more information and references & ﬁ* ’é'i
to the individual sidebar panels = ﬁld\ i la\

see the TechGuide entitled View  Layer  Magnifier Places
Window Sidebar. Transparency

Status Bar

The status bar at the bottom of the View window provides a
number of fields that report current information about the dis-
play. The field on the left side of the bar presents status messages
from the Display process. The position report fields show the
current point coordinates of a GPS source (if any), the mouse
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pointer position in the view canvas (if no GPS source), or the
center of the view canvas (if the pointer is outside of the view
canvas). The Coordinate Source Indicator changes to show
the coordinate source, as illustrated below. The precision for
the coordinates shown (number of decimal places) varies au-
tomatically with the scale of the display (more decimal places
as you zoom farther in).
Coordinate Source Indicator

@™ GPS Source @:ﬁ Pointer  [4] View center

Position report 1 shows coordinates by default in the coordi-
nate reference system in use in the view. Position report 2 by
default shows geographic (longitude/latitude) coordinates us-
ing the datum currently used by the view. Placing the mouse
cursor over either field reveals a ToolTip with the name of the
coordinate reference system for that field. Submenus on the
View window’s Options menu let you choose whether or not
to show either position report, to choose an alternate coordi-
nate reference system, and to set the format for geographic
coordinates (see below).

The Z value field shows the elevation at the current GPS loca-
tion or the elevation from the terrain layer (if any) for the current
cursor position or the view center (if the cursor is out of the
view). The field on the right side of the status bar shows the
current map scale ratio in the form 1:628384. The ToolTip for
this field shows several alternative forms for the current scale,
including 1 cm = X meters, 1 in = X feet, and the number of
map units per screen pixel.

View and Tools Menus

The View menu options correspond
to functions provided by various
icon buttons on the View toolbar. In
addition, an option is provided to
Open Additional View. The Tools
menu options pro-
vide an alternate
way to activate spe-
cific graphic tools
in the view. For
more information
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show GPS positions. Active GPS sources (if any) are shown
at the bottom of the GPS menu; a submenu for each source
provides the options to track the GPS position in the main view
and in the Locator. For more information see the TechGuide
entitled Track GPS Position.
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Options Menu

The Options menu provides a number of selections affecting
the appearance and operation of the View window and pro-
vides access to additional control dialogs.

Colors: opens the Select Colors window (illustrated above) in
which you can choose background colors for the view canvas
(Main Background) and Locator, colors for marked and active
elements and for elements highlighted on mouse-over, as well

as graphic tool colors. ) .
}g‘ G... [E=ERES é

Lock by

GeolLock Settings: opens the GeoLock
Settings window in which you can set
the mode for GeoLocking the contents
of multiple View windows. You can lock
by Extent and Scale, Scale Only, or by
Extent Only. For more information see
the TechGuide entitled GeoLock Views.

Stereo Settings: The geodata in any
View window can be rendered in stereo using a terrain layer.
This menu option opens the Stereo Settings window, which
lets you choose the stereo viewing mode (Device Settings) and
adjust the characteristics of the stereo rendering. See the
TechGuide entitled Stereo Display Settings for more informa-
tion.

{7 Extent and Scale

) Scale Only
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Relative Scale | 1.000
0K Cancel
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Snapshot Settings: opens the Quick Snapshot settings win-
dow allowing you to set the file format, destination folder, and
other options for view canvas snapshots captured using the
Quick Snapshot function. See the TechGuides entitled Quick
Snapshot of View Contents and Quick Snapshot for Google
Earth for more information.

DataTips: opens a submenu for setting general viewing op-
tions for DataTips in the View window.

J None
The menu provides toggle options allow-  a urestop Layer
ing you to quickly change the amount and . visible Layers

™ Maximum

type of information shown in DataTips, and
a Settings option that opens the DataTip

J Automatic by Scale

. . . J Object Names
Settings window providing further controlS. ging GeocodedLocation
For more information see the TechGuide Settings..
entitled View Window DataTip Options. (continued)
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Position Report: The Options menu has an entry for each of
the two Position Report fields in the status bar. These entries
each open a submenu with a Show toggle option that you can
turn on or off to show or hide that position report. The Refer-
ence System option on the submenu opens the Coordinate
Reference System window in which you can choose the refer-
ence system to be used for the coordinates shown in the report.
The Geographic Format option opens a submenu to select a
format option for geographic (longitude/latitude) coordinates.
The options are Deg Min Sec (Degrees Minutes Seconds), Deg
Min, Deg (decimal degrees), Min Sec, Min, and Sec.

Position Report 2 " W Show

Projection Accuracy Reference System...

= Redraw primary view after any change Geographic Format .

Projection Accuracy: opens a submenu from which you can
choose the accuracy level for layers that must be reprojected
to match the coordinate reference system currently in use for
the view canvas. The options are Fast and Exact.

Toggle Options: a number of toggle options are provided in
the middle portion of the Options menu. Two of the selections
set redraw options for the view canvas and the locator. The
Zoom when traverse marked elements option sets the View win-
dow behavior when multiple geometric elements have been
marked and the Previous Marked and Next Marked icon but-
tons are being used to step through the selected set (see theMark
Toolbar section in the View Window Toolbar TechGuide). With
this option turned on, the View window automatically zooms
to the extents of each successive marked element. Turn this
option off if you want to maintain the same view scale when
traversing marked elements.

Additional toggle options are provided to allow you to show or
hide the scalebar in the view canvas, the sidebar, and the status
bar. The Differential Zooming option applies to the Zoom tool.
The dimensions of the zoom box drawn with this tool are locked
to the proportions of the view canvas unless you turn on the
Differential Zooming option (see the section on the Zoom tool
in the View Window Toolbar TechGuide).

Macro Scripts and Tool Scripts: these options open the Cus-
tomize Macro Scripts and Customize Tool Scripts windows,
respectively, so you can add custom tools and functions to the
View window. See the tutorials entitled Introduction to
Geospatial Scripting and Writing Scripts with SML for more
information.

Customize: opens the Customize Hidden Features window,
which allows you to choose the items to be shown on the
View, Tools, and Options menus and to choose which icon
buttons to include on the View window toolbar. This feature
allows you to simplify the interface if certain options are not
needed or to provide additional tools for expert use. See the
TechGuide entitled Customize the View Window for more infor-
mation.

Hotkeys

<space > Recenter at cursor

HotKeys Menu

Keyboard shortcuts (HotKeys) can
be used to zoom and pan the view
canvas. The HotKeys menu pro-
vides a quick reference list of the
available keyboard shortcuts for the
View window.

<backspace > Previous view
\ Redraw

0 Zoom to full view

1Set zoom to 1X [image)

2 Set zoom to 2X (image)

3 Set zoom to 3X (image)

4 Set zoom to 4X (image)

6 Set zoom to 1/2X (image)
7 Set zoom to 1/3X (image)
8 Set zoom to 1/4X (image)
9 Set zoom to 178X (image)

+f= Zoom in

Scalebar

The optional scalebar in the view
canvas changes its length and units
(e.g., meters or kilometers) dynami-
cally as the scale of the display is
changed. You can set the proper-
ties of the Scalebar graphic by
right-clicking on the graphic to
open the Scalebar Settings window (illustrated below). This
window lets you set the scalebar style, location, units, font,
maximum bar length in pixels and how its map length changes
with zoom level.

- Zoom out

< Open zoomed-out view

» Open zoomed-in view

* Open additional [geolocked) view

* Center other views at cursor position

<arrows > Seroll 90 percent
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The panel on the right side of the Scalebar Settings window
provides a graphic selection of different scalebar styles, in-
cluding separate or combined scalebars for metric and English
units. This panel also serves as a preview of your other style
choices, including the label font you select from the Font menu
and the label size you select from the Text Size menu. The
Colors box provides color buttons for choosing the colors for
the interior and edge of the scalebar (Bar and Frame, respec-
tively) and the text label (Text and Halo, respectively).

Use the Location menu to choose where the scalebar is placed
along the bottom or top edge of the view canvas. The choices
are Bottom Left, Bottom Center, Bottom Right (the default),
Top Left, Top Center, and Top Right. Using the Units menu
you can choose to have a single scalebar in either Metric or
English units, or a pair of scalebars using both units. The
Metric + English choice places the metric scalebar on the left
(for separate scalebars) or on top (for a combined scalebar).
The English + Metric choice reverses these relationships.

The Step radiobuttons offer a pair of options for the numerical
progression of the scalebar labels as the view scale changes.
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